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USING ‘MS PAINT’ IN LEARNING DESCRIPTIVE TEXT  
  

By FATHUL MUIN  

  

ABSTRACT  

 This article discusses about how to use MS Paint in the teaching and learning process of 

descriptive text and the benefits of using it in writing class a descriptive text. The Process 

Standard suggests teachers to use Information and Communication Technology (ICT) in 

designing a lesson plan as one of strategies to make class more interactive, inspiring, joyful, 

challenging, and motivated. Through MS Paint students are able to develop their paragraph 

based on what they draw or paint on their computer. They have free choices or imagination 

of any picture that they want to draw. From their drawings, students can produce a 

descriptive paragraph better in terms of expressing ideas, vocabulary, sentence structure, 

and generic structure.  

Key words: paint, descriptive  

  

A. Introduction  

 Nowadays the role of Information and Communication Technology (ICT) in the education 

sector plays an important role, especially in the process of empowering the technology into 

the educational activities. Education sector can be the most effective sector to anticipate and 

eliminate the negative impact of ICT. ICTs are making dynamic changes in society. They 

are influencing all aspects of life. The influences are felt more and more at schools. Because 

ICTs provide both students and teachers with more opportunities in adapting learning and 

teaching to individual needs, society is, forcing schools aptly respond to this technical 

innovation. Tinio (2002), states the potentials of ICTs in increasing access and improving 

relevance and quality of education in developing countries.   

Being aware of the significant role of ICT in people‘s life, especially in the 

educational activities, education authorities should be wise enough in implementing the 

strategies to empower ICT in supporting the teaching and learning process in the classroom. 

ICT is not just the bloom of the educational activities, but also it will be the secondary option 

to improve the effective and meaningful educational process.  

The National Education Minister‘ decree number 41 of 2007 is about the Process 

Standard. It states that the process of teaching and learning should be interactive, inspiring, 

joyful, challenging, and motivating. Related to this, one of the principles of designing a 
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lesson plan is using integrated, systematic, and effective information and communication 

technology in accordance with situation and condition. The teacher has to know the right 

time when to use ICT during learning process of a certain basic competence. Only knowing 

techniques of teaching is not enough for teachers without applying an interesting way of 

teaching. Developing teaching materials is one of the ways how to create a joyful learning 

atmosphere inside or outside classroom.  

The teachers should be the main motivator and initiator of the ICT implementation 

at schools. The teachers should be aware of the social change in their teaching activities. 

They should be the agent of change from the classical method into the modern one. They 

must also be the part of the global change in learning and teaching modification.  

  Moreover, ICTs‘ benefits in the classroom and the education process are that:  

1. Offer the opportunity for more student centered learning,  

2. Provide greater opportunity for teacher-to-teacher and student-to student 

communication and collaboration,  

3. Give greater exposure to vocational and workforce skills for students,  

4. Provide opportunities for multiple technologies delivered by teachers,  

5. Create greater enthusiasm for learning amongst students,  

6. Provide teachers with new sources of information and knowledge,  

7. Prepare learners for the real world,  

8. Provide distance learners country-wide with online educational materials  

9. Provide learners with additional resources to assist resource-based learning.  

  

B. Pedagogic Aspects  

  Tinio (2002) describes each of the pedagogic aspects in terms of implication for ICT 

use as follows:  

1. Active learning: - ICT-enhanced learning mobilizes tools for examination, 

calculation and analysis of information in order to provide a platform for student 

inquiry, analysis and construction of new information. The learners therefore, 

learn as they do and, whenever appropriate work on real-life problems in-depth. 

Moreover, ICT makes the learning less abstract and more relevant to their life 

situations. In contrast to memorization-based or rote learning, that is the feature 

of traditional pedagogy; ICT-enhanced learning promotes increased learner 

engagement. ICT-enhanced learning can also be  

‗just-intime‘  

         learning that the learners choose what to learn when they need.  
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2. Collaborative learning: - ICT-supported learning encourages interaction and 

cooperation among students, teachers, and experts regardless of where they are. 

Apart from modeling real world interactions, ICT-supported learning provides 

opportunity to work with students from different cultures, thereby helping to 

enhance learners teaming and communication skills as well as their global 

awareness. It models learning done throughout the learner‘s lifetime by 

expanding the learning pace to include not just peers but also mentors and 

experts from different fields.  

3. Creative learning: - ICT-supported learning promotes the manipulation of 

existing information and the creation of real-world products rather than the 

duplication of received information.  

4. Integrative learning: - ICT-enhanced learning promotes a thematic integrative 

approach to teaching and learning. This approach eliminates the artificial 

separation between the different disciplines and between theory and practice, 

which characterizes the traditional approach.  

5. Evaluative learning: - ICT-enhanced learning is student-directed and 

diagnostic. Unlike static, text or print-based education, ICT-enhanced learning 

recognizes the presence of different learning pathways to explore and discover 

rather than merely listen and remember.  

  

C. Paint Program  

  Paint is a program that helps learners create pictures and graphics. They may learn 

how to:  

1. draw freehand shapes with the pencil.  

  The tool bar is on the left hand side of the window.  

• Click on the pencil button, then move your mouse pointer into the white painting 

area of         the window  

• Hold the left mouse button down and move the mouse around. As the mouse moves, 

a line is made on the page. The line stops when the mouse button is released.  

2. take out bits that you don’t want  

  There are three ways that you can take out bits that you don‘t want:  

• You can rub things out. Click on the Eraser button to make the pointer turn into 

a rubber. Point at the bits you want to take out, press the left mouse button and 

then move the mouse around.   
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• You can remove the last thing that you did. While holding down the Ctrl key 

(control key) on the keyboard, press the Z key. The last thing you did will 

disappear.  

• Start again completely.  

        Click on the Image menu option on the menu bar at the top of the screen, then click on 

the Clear Image option at the bottom of the list.  

3. draw in different colors  

     Towards the bottom of the screen is the Color Pallet. To draw in different colors, click 

on the color you want first. You can change colors at any time.  

4. draw circles and rectangles  

* Click on the Ellipse or the Rectangle buttons on the tool bar.  

* Point the mouse pointer at the place on the page where you want the shape to be.  * Click 

the mouse button, and while holding it down, move the mouse. A circle or rectangle will 

be made on the page. Its size and shape will depend on how you move the mouse.   

5. color in shapes, using the fill color button  

       *    Click on the Fill With Color button on the tool bar. Imagine this tool to be like 

a tin of  paint that you can pour to fill a shape you have already made  

• Choose the color that you want  

• Click in the shape that you want to color. It will be filled with the color you have 

chosen. You can change color at any time.  

6. save your work  

* Click on the File option on the menu bar at the top of the screen.  

* Scroll down and click on Save As. The Save As window will appear.  

* Open the Work folder. Your teacher will show you how.  

* In the File Name field towards the bottom of the window, type a name for the work.  

* Click on the Save button. Your work will be there ready to load and use again another 

time.  

  

D. Learning Writing of Descriptive Text through Paint Program  

 Teaching English means that teaching the students not only how to speak, how to read, 

how to listen, but also how to write. Communication not only can be done in spoken but 

also in written. Most of students consider that writing is the hardest skill to master, because 

the ability to write in foreign language is more complicated than the ability to speak, read, 

or listen. It is hard to teach students how to write because it involves many components 

such as structure, vocabulary, punctuation, and spelling. In writing, students will also find 
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many kinds of texts; one of them is descriptive text. People consider that descriptive text is 

an easy material, but in contrast, it is difficult because they have to write about the thing 

that exists and the thing that does not exist, something that cannot be seen, felt, smelt, or 

even touched.  

1. Theoretical Foundation  

a. Writing  

 Communication not only can be done in spoken but also in written. It is not an easy 

job to do because the writer has to be able to pour the idea as good as possible to 

what will they write. It is done to convey the message to the reader clearly. That is 

why writing is considered as the most difficult skill to learn.  

   Wilma and David R. Ebbit stated that ―writing is the act of joining words  

into sentences on paper‖. It means that writing is not just exercising the fingers but 

it is also necessarily the act of finding words to express definite, fully formed ideas. 

Writing activity is done to find out what are thinking, what is looking, and what it 

means.  

Writing is a tool to communicate between writer and the reader, by writing 

the writer can tell the reader about information, situation, and many others.  

Writing is an effort to create a dialogue with readers. And it involves exploring our 

relationship to our reader in much the same way that me explore our relationship  to 

people we talk to. Writing skill is a creative act. Through writing, we can make sense 

something such as experience, stories, text or events and many others. From writing, 

we can communicate each other, send a message and give  information to other 

people.  

  

  b. Definition of Descriptive  

 A descriptive paragraph is used to describe what a person looks and  catches. 

Writer is telling the reader how something strikes the sense, how it  looks, smells,  

sounds, and feels even something how it tastes. In teaching writing, teacher must be 

able to make an innovation and interesting method, to make his students easy to 

express their ideas. To improve his students, the teachers can use many ways such 

as using picture, own drawing, letters, movies, advertisement and many others. 

Every teacher has to choose the best techniques to make the students interested to  

learn.   

Descriptive details allow sensory recreations of experiences, objects, or 

imaginings. In other words, description encourages a more concrete or sensory 
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experience of a subject, one which allows the reader to transport himself or herself 

into a scene. The most important factor in writing exercises is that students need to 

be personally involved in order to make the learning experience of lasting value.  

Encouraging students‘ participation in the exercise, while at the  same time refining 

and expanding writing skills, requires a certain pragmatic  approach. The teacher 

should be clear on what skills he/she is trying to develop. Next, the teacher needs  to 

decide on which means (or type of exercise)  can facilitate learning of the target  

area. Once the target skill areas and means of  implementation are defined, the 

teacher can then proceed to focus on what  topic can be employed to ensure student 

participation. By pragmatically combing these objectives, the teacher can expect 

both enthusiasm and effective learning.  

2. Learning Descriptive using MS Paint   

Paint is a program used to draw, color, and edit a simple picture. You can use Paint 

like a digital sketchpad to make simple pictures and creative projects or to add text 

and designs to other pictures, such as those taken with your digital camera.  

The parts of Paint  

    To open Paint, click the Start button , click All Programs, click  

Accessories, and then click Paint. When you start Paint, you see a window that is mostly 

blank, with just a few tools for drawing and painting. The following illustration shows the 

different parts of the Paint window:   
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Working with tools  

  Paint includes a handy collection of drawing tools in the toolbox. You can use 

these tools to create freehand drawings and add a variety of shapes to your pictures.   

 This section describes some common tasks. For information on how to use 

each tool in the Paint toolbox, see Paint tools. Draw a line  

  Some tools, like the pencil, brush, line, and curve, let you make a variety of 

straight, curved, and wiggly lines. What you draw is determined by how you move the 

mouse as you draw. You can use the line tool to draw a straight line, for example.  

1. In the toolbox, click the Line  tool .  

2. In the Color box, click the color you want to use.  

3. To draw, drag the pointer across the drawing area.  

Draw a squiggly line  

 Your drawings don't have to be composed of just straight lines. You can use the Curve tool 

to  create smooth curves, for example. The Pencil and Brush can be used to make completely 

random, free-form shapes.  

1. In the toolbox, click the Pencil tool   .  

2. In the Color box, click the color you want to use.  

http://windows.microsoft.com/en-US/windows-vista/Paint-tools
http://windows.microsoft.com/en-US/windows-vista/Paint-tools
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3. To draw, drag the pointer across the drawing area. Draw a shape  

 Some tools, like the Rectangle and ellipse, let you add shapes to your drawing. The 

technique is the same regardless of which shape you choose. For example, you can use the 

Polygon tool to draw a polygon, which is a shape that can have any number of sides.  

1. In the toolbox, click the Polygon tool   .  

2. In the Options box, click a fill style:  

Fill options  

o Outline. Your shape will be just an outline, with a transparent interior. o 

 Outline with fill. Your shape will be filled with the current background 

color. (To set a background color, in the Color box, right-click a color.)  

o Solid. Your shape will be filled with the current background color, but it 

will not have any outline.  

3. To add a polygon, drag the pointer across the drawing area, and then click to end 

the first side.  

4. Drag the pointer to create the next side, and then click to end the side. Repeat this 

as needed for additional sides.  

5. To create the final side and close the polygon, double-click. Erase part of your 

picture  

 If you make a mistake or simply need to change part of a picture, use the eraser. By default, 

the eraser changes any area you erase to white, but you can change the eraser color. For 

example, if you set the eraser color to yellow, anything you erase turns to yellow.  

1. In the toolbox, click the Eraser tool .  

2. In the Color box, right-click the color that you want to erase with. If you want to 

erase with white, you don't have to select a color.  

3. Drag the pointer over the area you want to erase Changing the effect of the 

drawing tools  

 The Options box, located below the toolbox, is where you can change how a tool draws. 

You can set the thickness of the tool's brush (which affects the weight of what you draw on 
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the screen) and whether the shapes you draw are outlined or solid. Change the brush stroke 

of the Brush  

1. In the toolbox, click the Brush tool .  

2. In the Options box, click the brush shape you want to paint with.  

Picture of brush options  

3. To paint, drag the pointer across the drawing area. Saving a picture  

 Save your picture frequently to ensure that you don't accidentally lose your work. To do 

that, on the File menu, click Save. This saves all of the changes you made to the picture 

since the last time you saved.  

 The very first time that you save a new picture, however, you will need to give your picture 

a file name. Follow these steps:  

1. On the File menu, click Save.  

2. In the Save as type box, select the file format you want.  

3. In the File name box, type a name.  

4. Click Save.  

Paint tools  

 Paint is a program you can use to create drawings on a blank canvas or on top of other 

pictures. The program features a toolbar on the left side of the window. The following tables 

describe how to use each of the tools on this toolbar.  

Tool  Description   

 Use Free-Form Select to select any irregularly shaped part of the picture. Click Free- 

  



The Proceedings of National Seminar  

 Tool  Description   

   Page    

 85    

Form Select, and then, in the options box just below the toolbar, click a background 

style. Drag the pointer to select the part of the picture you want to work with.   

Use Select to select any square or rectangular part of the picture. Click Select, and  

then, in the options box just below the toolbar, click a background style. Drag the  

  

pointer to select the part of the picture you want to work with.   

Use the Eraser to erase areas of your picture. Click Eraser, click an eraser size below 

 the toolbox, and then drag the Eraser over the area of the picture that you want to  

  

erase. Any areas that you erase will be replaced by the background color.  

Use Fill With Color to fill the entire picture or an enclosed shape with color. Click Fill  

With Color, click a color in the Color box, and then click inside the area you want to  fill. 

To remove the color and replace it with the background color, right-click the area where 

you want to remove the color.  

Use Pick Color to set the current foreground or background color. Click Pick Color,  

and then click the color in your picture that you want to set as the foreground color, or  

  

right-click the color in your picture that you want to set as the background color.  

Use the Magnifier to zoom in on a section of your picture. Click Magnifier, and then click 

a zoom level just below the toolbar. Use the scroll bars to move around the  picture. To return 

to a normal view, click the Magnifier again, and then click in the picture.  

Use the Pencil to draw thin, freeform lines or curves. Click Pencil, click a color in the  

 Color box, and then drag the pointer in the picture to draw. To draw using the  

  

background color, right-click while you drag the pointer.  

Use the Brush to paint thick or shaped freeform lines and curves. Click Brush, click a 

 shape just below the toolbar, click a color in the Color box, and then drag the pointer  

  

to paint. To paint using the background color, right-click while you drag the pointer.  
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Use the Airbrush to create an airbrush effect in the picture. Click Airbrush, click a spray 

pattern just below the toolbar, click a color in the Color box, and then drag the  

 
 pointer to paint. To paint using the background color, right-click while you drag the pointer.  

Use Text to enter text in the picture. Click Text, and then, in the options box just  

below the toolbar, click a background style. Click a color in the Color box, and then  

  

click in the picture and type your text. You can resize and move the text box, and 

change the font, font size, and text formatting until you click another tool or click 

outside the text box within the picture.  

Use Line to draw a straight line. Click Line, click a line width in the options box just 

below the toolbar, click a color in the Color box, and then drag the pointer in the  picture to 

draw the line. To draw a line using the background color, right-click while you drag the 

pointer.  

Use Curve to draw a smooth, curved line. Click Curve, click a line width in the options 

box just below the toolbar, click a color in the Color box, and then drag the  pointer in the 

picture to draw a straight line. After you have created the line, click the  

  

area in the picture where you want the arc of the curve to be, and then drag the pointer 

to adjust the curve.  

Use Rectangle to draw rectangular shapes. Click Rectangle, click a color in the Color 

box, and then click a rectangle style in the options box just below the toolbar. To draw  a 

rectangle, drag the pointer diagonally in the direction you want. To draw a square, hold 

down SHIFT while dragging.  

Use Polygon to make a shape with any number of sides. Click Polygon, click a color in 

the Color box, and then click a polygon style in the options box just below the  toolbar. To 

draw a polygon, drag the pointer to draw a straight line. Then, click each  

  

point where you want additional sides to appear. Double-click when you're done. To 

create sides with 45- or 90-degree angles, hold down SHIFT while making sides.  
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Use Ellipse to make ellipses and circles. Click Ellipse, click a color in the Color box, 

 and then click a fill style in the options box just below the toolbar. To draw an ellipse,  

  

drag the pointer. To draw a circle, hold down SHIFT while dragging.  

Use Rounded Rectangle to draw rectangular shapes with rounded edges. Click 

Rectangle, click a color in the Color box, and then click a fill style in the options box  just 

below the toolbar. To draw a rounded rectangle, drag the pointer diagonally in the  

  

direction you want. To draw a square with rounded edges, hold down SHIFT while 

dragging.  

The Color box indicates the current foreground and background colors. To paint with 

the selected foreground color, drag the pointer. To paint with the selected background  

color, right-click while you drag the pointer. To change the current foreground color, click 

an available color square. To change the background color, right-click an available color 

square. To mix a new color, double-click in any color square, and then click Define Custom 

Colors.  

  

3. Examples of the students’ works  

 1)             2)  

                     

  

4. Benefits of using Paint program in writing descriptive text  

a. Vocabulary  

Even though students do not know an English word of something but they 

express it through a drawing. They will look in the word in their dictionary after 

finishing painting. They are free to express difficult words through painting. 

They may ask their friends or teacher of difficult words they have in their 
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painting. Automatically, the students will have more and more vocabulary by 

doing this activity.  

b. Structure  

 Students only produce simple and correct sentences based on their drawings.  

They can develop their sentences using a conjunction of ‗and‘. They can write 

a simple noun phrase. They can use adjectives, pronouns, and verbs in their 

sentences correctly because they write very carefully based on their drawings 

or paintings on the computer.  

c. Generic structure  

Students are able to write a descriptive text with good generic structure. They 

start their sentences by identifying the picture they paint and describing it. d. Ideas  

As students paint by themselves, they can develop their short paragraph. They 

can describe the thing or person they paint. In short, the students can write 

what they express through their painting.  

 

The problems that appear during teaching and learning process is not all 

students can paint through computer well. They need extra time to draw even 

ask someone‘s help to paint. It can be overcome by giving task to finish 

painting at home. Another problem is incomplete sentences, for example 

omitting to be or no verb. The teacher has to reinforce this activity in building 

knowledge of field step to anticipate this problem. 5. Conclusion Information 

communication technologies are influencing all aspects of life including 

education. They are promoting changes in working conditions, handling and 

exchanging of information, teaching-learning approaches and so on. One area 

in which the impacts of ICT is significant, is education. ICTs are making major 

differences in the teaching approaches and the ways students are learning. ICT-

enhanced learning environment facilitates active, collaborative, creative, 

integrative, and evaluative learning as an advantage over the traditional 

method. In other words, ICT is becoming more appropriate in the realization 

and implementation of the emerging pedagogy of constructivism that gives 

greater responsibility of learning for students. Through painting program, 

students will be able to write a descriptive text better than describing a picture 

only because they have ideas to express from what they think in mind and 
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express it into painting and sentences. This program helps them to write well as 

they have imagination through a picture they paint.  
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